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Netscape, the Web browser we've included on the Yahoo! Internet Life CD-ROM, is
an easy and sophisticated program that lets you roam the World-Wide Web. We've 
written this help file to get you started with Netscape. Once you're up and running, you 
can always check back here for details on making the most of Netscape, or you can 
click on the Netscape icon (in the upper-right-hand corner of the browser screen) to go 
to the Netscape site for more info.

Welcome!

Introduction to Netscape
Using the navigation buttons (aka the Toolbar)
Using the menus
Setting your preferences
Using the bookmark list

About the World-Wide Web
About Yahoo! Internet Life
About Netscape
About this help file



About this help file

Copyright 1996, Ziff Communications Corp. All rights reserved. "Netscape" is a 
trademark of Netscape Communications Corporation. "Yahoo!" is a trademark of Yahoo!
"Yahoo! Internet Life," and "Rate-o-Matic" are trademarks of Ziff Communications 
Corporation. Lincoln is the capital of Nebraska.

This help file was written by Angela Gunn for Yahoo! Internet Life. If you have any questions or comments, my e-mail 
address is agunn@zd.com. I also run the Yahoo! Internet Life Web site, so you can reach me there -- check out my 
staff page at www.zdnet.com/zdil/content/misc/staff/gunn.html.



About Yahoo! Internet Life

Yahoo! Internet Life is brought to you by the nice people at Ziff-Davis and the other nice 
people at Yahoo!, working together to make the Web fun. You're actually looking at one-
third of the Yahoo! Internet Life scene -- we're also a Web site (located at 
www.zdnet.com/zdil) and a magazine, which presumably you were holding in your 
hands until you took the CD-ROM off of it and installed this software. If you didn't have 
the magazine but find yourself in possession of this file anyway... well, we need to talk.

And now for the staff list:
Bill Machrone is our editor-in-chief, our fearless leader
Elisabeth Holzer is the editor of the paper part of Yahoo! Internet Life
Angela Gunn is the Web doyenne (the editor of the Web part of Yahoo! Internet Life); 
she also wrote this help file.



You can write to Bill Machrone via e-mail at bmachrone@zd.com, or send him snail mail in care of Yahoo! Internet 
Life, One Park Avenue, New York, NY 10016.



You can reach Elisabeth Holzer at eholzer@zd.com, or send her snail mail in care of Yahoo! Internet Life, One Park 
Avenue, New York, NY 10016.



You can reach Angela Gunn at agunn@zd.com or at agunn@pipeline.com. She almost never bothers to open her 
snail mail so it's probably not worth the trouble of sending any.



Netscape Navigator is a trademark of Netscape Communications Corporation, all rights reserved. Netscape 
Communications, Netscape, Netscape Navigator and the Netscape Communications logo are trademarks of 
Netscape Communications Corporation. The Netscape home page is located at http://home.netscape.com. Go 
Mozilla!



The Forward button helps you retrace your steps after using the Back button. if you have backtracked for 
whatever reason, you can use the Forward button to move back along the path you had been following.



The Home button takes you to whatever page you normally load when you start up Netscape. You may 
change your "home page" in the Preferences menu.



The Reload button gets a fresh copy of the page you're looking at from its home server. This is useful in 
case you are looking at a page that is updated regularly or if for some reason the page didn't reach your 
machine in good condition.



The Images button is used if you have chosen (in the Preferences menu) to not load Web page graphics 
automatically. Use this button to load the images on a page-by-page basis. (In this screen, the Images 
button is greyed out because we had already loaded the images on that page.)



The Open button lets you type in the URL of a Web page you wish to load.



The Print button allows you to send a copy of any Web page to your printe. You'd guessed that though, 
right?



The Find button allow syou to look through the text of a Web page to find a specific word of words. Know 
that the Find button doesn't always work particularly well. 



The Stop button allows you to interrupt a Web page while it loads. This is useful if you decide you don't 
need to see the page in question, or if Netscape appears to be "stuck" for some reason. (In this screen, 
the STop button is greyed out because we were not loading a page at the time.)



Preferences

You can control much of the way Netscape looks and behaves by setting your 
preferences under the Options menu. To find out more about the many options under 
the Options/Preferences menu, please click on one of the folder names listed below.

Applications and Directories
Cache and Network
Colors
Fonts
Helper Apps
Images and Security
Mail and News
Proxies
Styles



Using the navigation buttons
(aka the "Toolbar")

The top of your Netscape screen has several buttons that help you move around the 
Web. Click on the button bar shown below for explanations of each button.

You may change the appearance of your button bar to show only pictures, only words, 
or both pictures and words Change the button bar in the Styles folder, under the 
Preferences choice in the Options menu.



Styles

The Styles folder of the Preferences menu allows you to change the appearance of the 
Toolbar, choose which Web page you'd like to see when you start Netscape (if any), and
decide how links ought to look on your pages. Click on the Styles folder shown below 
for more information on any option.

To save your changes, click OK.
To cancel your changes, click Cancel.



Click here to show the toolbar with only pictures. This style is attractive but takes up slightly more room 
onscreen than the text-only option.



Click here to show the toolbar with text-only labels. This is a good method of gaining a bit more room 
onscreen for Web pages.



Click here to display the toolbar with both pictures and text labels. This is the easiest display to 
understand, but it takes the most onscreen room of the three toolbar options.



If you choose this option, Netscape with start without loading a Web page. You may choose a Web page 
once Netscape has started by using the Bookmarks menu.



Choose a Web page for Netscape to automatically load at startup by clicking the Home Page Location 
button and typing a URL (Uniform Resource Locator) into this space. In this case, the Web page 
www.zdil.com will load whenever Netscape is started. This is also the page to which Netscape will return
when you click the "home" tool on the Toolbar.



Choose this to have Netscape underline every link and put a box around graphics with links. This makes it
easier to see the links (including hidden links -- we hide a lot of secret links on the Yahoo! Internet Life 
for intrepid explorers!), but it's not aesthetically pleasing.



Click here to have Netscape keep a record of every link you've ever clicked. The links you've clicked will 
be shown in a special color, which you may choose in the Colors section of the Styles menu. This is very 
convenient, but it takes up a lot of space in your hard drive.



Choose this option to have Netscape keep your links for a certain period of time. By default, Netscape 
keeps track of your links for 30 days. During that time any link you've already followed will show up in a 
special color, which you may choose in the Colors section of the Preferences menu. After 30 days (or the 
amount of time you choose), the link will revert to its normal color.



Click here to have Netscape "forget" all the links you've asked it to mark in the I-followed-it color. The next
time you click a link, Netscape will start keeping track once again.



Proxies

Proxies are important if you're operating your copy of Netscape behind a firewall -- that 
is, in an office environment with special security measures added to the Internet 
hookup. If this applies to you, please talk with your network administrator about 
Netscape, since you probably shouldn't load any Internet software on their network 
without consulting them. (They may even have it already installed for you!)



The Back item in the Go menu and the Back button on the tool bar do the same thing --move you to the 
last Web page you looked at. If the button or menu item is greyed out, you cannot back up past this page.
(On the Toolbar screen, the Back button is greyed out because we were as far back in our session as we 
could get.)



The Forward menu item under Go and the Forward button do the same thing -- retrace your steps after 
using the Back button or menu item. NOTE: If you use the Back button or menu item and then start along 
a new path, Netscape will "forget" the earlier path.



The Home button on your toolbar and the Home item on the Go menu do the same thing. Use either to 
return to your "home page," the Web page that Netscape loads when you start a new session. Change 
your home page on the Styles screen.



The Reload button and the Reload option under the View menu do the same thing. Each goes to the URL 
for the page you currently have onscreen and re-retrieves it. This is useful if the page for some reason 
didn't make it to your computer in good shape, or in case you think you have retrieved a "stale" copy of 
your page from a cache somewhere in your or your Internet service provider's computer.



Cache



The Images button and the Load images item under the View menu do the same thing. You'll use them if 
you have chosen (in the Preferences menu) not to load Web page graphics automatically. Use the button 
or the menu item to load the images on a page-by-page basis. (If a page's images have already been 
loaded or if you have selected to auto-load images under the Preferences menu, the button and menu 
item will be greyed out.)



Options

Various aspects of Netscape can be changed in the Options menu and its 
subdirectories. Click one of the menu topics below for more information.

Preferences
Show Toolbar
Show Location
Show Directory Buttons
Auto-Load Images
Show FTP File Information
Save Options



Use the Open option on the Toolbar to type in a URL to which you'd like to go. You may also type URLs 
directly into the URL space just above the Web page display area, or you may choose a URL from your 
Bookmarks.



Use the Print option to send a copy of the current Web page to your printer. (You probably suspected as 
much, didn't you?)



Use the Find function to locate a word or words on the current Web page. (Author's note: In my 
experience this simply doesn't work very well. If you really must search a page, use the File/Save As 
option to save a copy to your hard drive and use Notepad or Write to do the dirty work.)



Use the Stop button or the Stop item on the Go menu to halt a Web page in the process of loading. This 
is useful if you suddenly decide you don't want to load a slow page, or if something appears to have gone 
wrong when you tried to load. (If the button or menu item is greyed out, it's because the page has already 
finished loading.)



The Netscape Menus

The Netscape menu bar gives you absolute control over what Netscape does. To find 
out more about each menu item, click on its name below.

Bookmarks
Directory
Edit
File
Go
Options
View



Bookmarks

The Bookmarks menu item really is what you make it. There are only two commands on
here; the rest of the items on the list are totally up to you! As you travel the Web, you'll 
find sites that you'll want to return to. You may make a bookmark on your computer so 
you can find the site again without jotting down the URL. 

To make a bookmark, click the "Add bookmark" item on the Bookmark menu (or just hit
Cntl-A). The bookmark will appear on the list below next time you open the Bookmark 
menu. It will appear under the title created for the page by the Web designer.

To use your bookmarks, open the Bookmark menu and click on the title of the 
bookmark you want. If your bookmark list becomes too long, you won't be able to see all
of it at once; click the "View bookmarks" item to open up a longer view of your list. 

If you need to change the title of a bookmark (some designers don't name their 
pages very well!), click the "View bookmarks" item, then click the "Item" item, then click 
"Properties." You can edit the title in the Name: field. Do NOT edit the Location field; this
is the URL for the page for which you made the bookmark.

To sort your bookmarks, you may create subdirectories and dividers in the bookmark 
list. Use the "Create header" item under Item/Properties to make folders; you may drag 
and drop individual bookmarks into the new folder. Use the "Insert separator" item to 
make a line between folders or bookmarks.



Directory

The Directory is a pre-set bookmark list that Netscape provides to help guide you to 
interesting Netscape-related spots on the Web. Explore the Directory at your leisure!



About the World-Wide Web

Really, the best way to find out about the World-Wide Web is to fire up Netscape and 
start exploring. After all, isn't that why you're reading Yahoo! Internet Life?

Oh, OK. The World-Wide Web (now and ever after known as the Web) is part of the 
Internet (now and ever after known as the Net). The Internet is a worldwide collection of 
computers in businesses, schools, governments, organizations and private homes, 
linked by what for the sake of argument we'll call giant phone lines, along with some 
not-so-giant ones such as -- well, such as the one in your house once you start up 
Netscape.

The World-Wide Web is the part of the Internet that brings itself to you in multimedia. 
That is, the Web can let you look at pictures of your favorite band while listening to their 
latest single and reading reviews from their concerts. And the Web is set up to do that 
for you even if the pictures are in Sweden, the music is in L.A., and the reviews are in 
newspapers around the world. You don't need a computer science degree, either -- just 
a working mouse finger and a bit of curiosity. All the components of the Web are 
connected by "links" that you'll see onscreen as you move from place to place. You 
already know how to use links -- you did exactly that when you clicked to get from the 
main Help page to this page!

All you have to do to get started in Netscape is follow the links you'll see on the Web 
pages you go to. It really is that easy. But Netscape can help you handle the Web like a 
pro, keeping track of where you've been and where you might want to go to again. 
That's why we like it and that's why we put it on this CD-ROM for you. And you can 
make Netscape as personalized as you like. We'll show you how.

Behind the scenes is an alphabet-soup world of URLs and HTML not to mention HTTP, 
SMTP, POP, FTP and your ISP. Again, you don't have to know any of this. This help file
will introduce you to the one acronym (URL) that really matters to your world and we'll 
give you a glimpse of HTML, the "secret code" that creates those beautiful Web pages. 
(And isn't that all the alphabet soup anyone really wants at one sitting?)

There's plenty to see and do on the Web; that's why Yahoo! Internet Life is here. We're
pleased to help you get started online with Netscape; be sure to drop by and visit us on 
the Web!



The ISP (Internet Service Provider) is the company that gives you an Internet account. There are 
thousands of ISPs in America, including such companies as Netcom, CompuServe, UUnet, and PSI.



FTP (file transfer protocol) is the tool Netscape uses to moves all those sights and sounds from Point A to 
Point B. It's also a tool you can use to download programs and games from the Net. Netscape makes 
FTP as easy as clicking a regular Web link.



POP (Post Office Protocol) is a method of handling e-mail. In an unrelated sense it stands also for Point 
of Presence, which is a way of saying how big an Internet service provider (company giving you an 
Internet account) is. You do not need to know this fact, but it could be useful trivia at parties.



SMTP (Simple Mail Transfer Protocol) is a tool computers have for handling e-mail. This is stuff you really,
really don't need to know. You worry too much if you're clicking on this kind of thing, I think. Wouldn't you 
rather go online and play with the Internet instead?



Every Web page has a URL (Uniform Resource Locator), a unique "address" for that page. Links on a 
Web page contain URLs which direct the browser to the Internet site that holds the pages to which the 
designer wished to link. If you find a Web page you like, you'll be able to find it again if you take note of its
URL (or if you make a note of the URL via Netscape's Bookmark function).



HTML: The Language Of Web Pages

HTML (Hypertext Markup Language) turns plain-text files into Web pages. It's a bit like 
the formatting commands in your word processor. HTML is a set of instructions that tells
your browser how to format the information on the page. In an HTML document such as 
the one shown in part below, you can see the HTML commands enclosed in <brackets>.

Would you like to see some HTML for yourself? Here's the before picture...

...(gulp) and here's the after before:

Some makeover, hmm?



HTTP (Hypertext Transfer Protocol) is how computers on the Web explain the Internet to each other. You 
may notice the letters "http" followed by a colon and two slashes at the beginning of many URLs 
(addresses for Web pages). 



Getting To Know Your Netscape Browser

The Netscape browser lets you look at (browse!) Web pages all around the world. Think
of Netscape as a frame around the pictures you see online.

The browser looks the same no matter what Web page you look at. Click on the screen 
below to find out what each part of the browser does; for more information, follow one of
the links below the screen.

Navigation menu
Navigation buttons (aka the Toolbar)
Giant N
Location
Web page
Security key
Status display



The navigation menu contains all the commands you can use to navigate the Net and to control how 
Netscape works for you.



The toolbar contains Netscape's most-used tools for navigating the Web.



The N in the corner shows you when a Web page is loading onto your machine. It's also a very fast way 
of moving to the Netscape Web site.



The Location bar shows you the URL for the Web page you're currently looking at or loading into your 
browser. You may also type URLs into this space to move directly to them on the Web.



This is a Web page. It has icons, links and text.



This key indicates whether you are looking at a "secure" Web page. Secure Web pages are popular for 
transmitting credit-card numbers and other confidential information.



This bar gives information on whether you've reached the Web page you're trying to connect to. The short
bar in the right-hand corner turns red as a new Web page loads.



Tales Of The Giant N

The N in the upper right-hand corner of the Netscape screen is more than just a pretty 
picture. It will help you get to the Netscape site if you so desire; more importantly, it will 
help you to know how things are going with your Web connection.

When you click on a link (or type a URL into the location bar and hit Enter), the N in the 
corner will be showered with comets. As long as the comet shower continues, your 
chosen page is on its way to you. When the comets stop falling, the page you've chosen
has finished loading.

You may also click on the N to reach the main Netscape page. The Netscape site has a 
number of interesting links, including updates for your browser.



The location bar, located just below the toolbar, shows you the URL for the Web page you're currently 
looking at. To speed up your Web travels, you can type a URL directly into the location bar and press 
"enter" onyour keyboard. You may also use Windows' copy-and-paste capability to paste a URL into the 
location bar from another file such as an e-mail message.



The Security Key

The security key in the lower left-hand corner of the Netscape screen is there to remind 
you whether you are looking at a page that uses Netscape's security features. (You will 
also see a blue band just below the location bar on such pages.) The Netscape browser
is able to show and transmit pages that use "S-HTTP" (Secure HTTP). This variation on 
HTTP is designed to handle sensitive information such as credit-card numbers. It uses a
special method that is hacker-resistant.

Most Web sites tell you when you are entering and leaving pages that use security. In 
addition, some pages will warn you when you are about to send potentially sensitive 
information from a page that does not use security measures. By and large it's safer to 
send your credit-card numbers across the Internet than it is to hand your credit card to a
cashier or waiter; still, secure pages provide an extra measure of safety.



Using The Status Display

The two areas of the status display let you keep an eye on the progress of the Web 
pages and other files you download. It also gives you information about the links on the 
Web page you're viewing before you follow them.

On the left, the message bar will show a series of messages as you load your page. 
Roughly in order, these are:
Connect: Looking up www.your.page.com -- the system is asking the rest of the 
Internet where to find the computer that has the page you want
Connect: Contacting host -- the system has located the computer 
Connect: host contacted. Waiting for reply. -- the system is asking if the page you've 
requested is available.
Host contacted: Receiving... -- the file is available and it's on the way.
Reading file... Done. -- the file you've requested is being read.
Document: Receiving X of X bytes -- the file is being received and processed by your 
modem and browser.
Document: Done -- it's here.

As you view each page, you can see the URL for each link by placing the cursor on the 
link and reading the link's URL in the status bar.

On the right you'll see a status bar; it turns red from left to right as you load each Web 
page. When the page has finished loading, the red bar will disappear.



Edit

The Edit menu has the usual things you'll find in a Windows application: Undo, Cut, 
Copy, Paste and Find. You've used these before, you'll use them again, but you 
probably won't use them now. Let's move on, shall we?



File

The File menu has a motley collection of functions. Most of them are designed to let you
keep and use Web pages on- and off-line.

New window -- opens a second Netscape window. This is useful if you want to keep 
one page up constantly while you travel the Web. (Try this with the Review Tool on the 
Yahoo! Internet Life site!)

Open location -- lets you type in a new URL to see. You will usually do this through the 
location bar.

Open file -- lets you look at a Web page on your local hard drive. This is useful if you 
have saved a Web page from the Internet onto your own drive for later (local, faster!) 
viewing; it's also an important tool if you decide to design your own pages.

Save as -- lets you save a copy of any Web page to your own hard drive. This is good if 
you find a long Web page with information you'd like to keep handy. (Note: Saving a 
page doesn't mean you've saved the graphics on the page! To save a graphic, use the 
right mouse button and click on the graphic. You'll get a menu of choices, including a 
"save as" option.

Mail document -- click here to bring up an e-mail application that will let you mail cool 
URLs to any e-mail address. To use this option, you may need to configure Netscape's 
mail options in the Preferences menu.

Document info -- this screen gives you basic information about the Web page.

Page setup -- allows you to set up printer parameters.

Print -- lets you print a Web page (with graphics).

Print preview -- lets you look first.

Close -- closes this Netscape window.

Exit -- as P.T. Barnum said, this way to the egress.



Go Menu

The Go menu has functions that let you navigate the Web. Because these functions are 
so important to Netscape, all but one of them is replicated on the Toolbar.

Back
Forward
Stop Loading
Home
View History



Mail And News

This menu will allow you to set your Netscape browser to send e-mail messages and to 
read messages in Usenet newsgroups. It's pretty basic, but you'll be able to send cool 
URLs to your friends and have an idea of what's going on in your favorite newsgroups.

Click on the screen below for details on setting your mail and news information. You'll 
need to get some information from your Internet service provider (ISP) to fill in these 
blanks.

Netscape is developing much, much more useful mail and Usenet support for Netscape;
soon you will be able to use your browser to gracefully handle all your e-mail and 
newsgroups. Watch the Netscape site (click that N!) for details.



Usenet is a large set of discussions on virtually any topic you can imagine. The discussions take place on 
"threads" started and continued by people all around the world. Usenet newsgroups reach beyond the 
Internet onto other computer systems, but they've gained their greatest prominence as part of the Net. 
Usenet is a wild and wooly territory, with heated discussions and genuinely unique characters.



Type the name of your mail server in this space. You'll need to get this information from your Internet 
service provider, but it's likely that it'll be something like this, with "pipeline.com" replaced by your own 
service's domain name. (The domain name is the part of your e-mail address after the "@".)



Type your name here.



Type your e-mail address here.



If you'd like to include your business name in certain messages, this is the place to type it.



Some people like to include a brief signature file with information about themselves at the end of their e-
mail and Usenet messages. If you'd like to do so as well, create it in Notepad and type the name of the 
file here. (Netiquette note: Short and sweet is the rule here. Test your "sig" before unleashing it on the 
world, and keep it to four lines or fewer.)



Type the name of your news server here. You'll need to ask your Internet service provider (ISP) for this 
information, but it's generally your domain (the part of your e-mail address after the "@") preceded by the 
word "news."



Type the name of your news directory here; the answer shown is by and large the right one for you.



This option lets you choose how many Usenet messages will be shown to you at once. Keeping the 
number low lets you read them in small batches, but if your favorite newsgroup has heavy traffic you may 
want to read more messages at one time. (Author's note: 100 is a very high number; start with 15 and 
work your way up.)



Use this item to select whether Netscape should show you the navigational buttons (the toolbar). Clicking 
the item adds and removes a checkmark; if the item is checked, the toolbar will be displayed.



Use this option to choose whether Netscape will display the location bar just above the Web-page 
window. Clicking the item will add and remove a checkmark; when the item is checked, the location bar 
will appear.



Use this item to choose whether Netscape will display a set of buttons that guide you to various other 
Web pages. (In the screens we show, these buttons are NOT displayed, but if they were they would 
appear above the Web-page window.) Clicking the menu adds and removes a checkmark next to the 
item; if the item is checked, the buttons will be displayed.



Click here to save the options you've chosen.



The auto-load images item gives you the option to not load all graphics automatically. This detracts from 
the design of the Web pages you'll find (and some pages rely on their graphics), but it's useful if you have 
a slow connection to the Internet. Clicking on this item adds and removes a checkmark. When the item is 
checked, graphics will automatically load.

If you choose not to load your graphics automatically, you can retrieve them page-by-page by clicking on 
the Images button on the Toolbar.



From time to time you may wish to download non-Web files through your Netscape browser from FTP (file
transfer protocol) areas of the Internet. If you reach an FTP site, your browser will display information 
about each of the files available. If you don't wish to see this information automatically, clicking this item 
will keep the information from appearing on your screen. If there is a checkmark next to this option, you 
will automatically download the information.



Setting Your Fonts

Netscape gives you a small collection of pre-chosen fonts to help you make the screens
you see more easily readable. As the Web stands now, designers have no control over 
which fonts you choose to use, but they generally expect that your browser is using the 
default font settings provided in the Netscape package, so changing them is not 
recommended. Click on the image below for more information on the Fonts screen.



Use this to have your browser translate the pages according to the Japanese character set. It's highly 
recommended that you not change its setting from the Latin1 option shown.



Use this option to choose which of the fonts on your computer Netscape should use to display the 
"normal" text. (Author's note: Most designers assume that you will not change this setting; page 
appearances may vary widely from what the deisgner had in mind if you change the fonts.)



Use this option to choose which of the fonts on your computer Netscape should use to display the 
"preformatted" text used to show special passages and excerpts of code, and non-HTML pages. (Author's
note: Most designers assume that you will not change this setting; page appearances may vary widely 
from what the deisgner had in mind if you change the fonts.)



This option can be used to change your default encoding amongst the standard Latin1 (English) character
set and several non-Latin sets. It is strongly recommended that you select the auto-select option.



The View History menu allows you to quickly jump back to a page that you saw earlier in your Web 
session. Choose a Web page from the list. (Author's note: The History doesn't keep a perfect record; if 
you tend to jump back and forth during a session, you may find that Netscape has "forgotton" that you 
took certain links.)



The View Menu

The view menu contains options which affect how the page you've just loaded looks 
onscreen. These functions are so important that two of them (Reload and Load images) 
are duplicated on the Toolbar.

Reload
Load images
Refresh
Source



Use the Source option to see the HTML underpinnings of the Web page onscreen. This is mainly useful 
for designers, who may want to see how a particular Web page works or why it doesn't.



The Refresh option lets you reload a Web page from your own local cache. This is useful in case a 
graphic didn't load properly for some reason; if you have seen it already during a Web session it's likely 
that you can refresh it from cache, which is faster than reloading it from the computer on the Internet.



Cache is an area of your computer's memory where it stores pages (and other items) that you have 
recently seen through the browser. Keeping a cache of pages and graphics helps to speed up the 
browser. Many programs besides Netscape use cache to speed up their performance.



In Living Color

The Colors page allows you to change the colors Netscape uses to display links, text 
and Web page background. Click on the image below to find out about the Colors 
screen.



Choose here to let Netscape use either your preferred colors at all times or any colors the page designer 
might have specified. (If the designers didn't specify special colors, yours will be used.) It's preferable to 
allow Netscape to load any document-specific colors, as shown.



Click here to choose a special color in which Netscape can display links. The default color is blue, as 
shown.



Click here to choose a color in which Netscape can display links you've already followed (so you know 
you don't have to folow them again). The default color is red; here we see that a grey "custom" color has 
been chosen.



Click here to chose a color in which Netscape can display the "normal" text (text without links). The 
default color is black, as shown here; since many designers like to use colored backgrounds, it's 
preferable that you keep black as your text color.



The Background options allow you to choose either a background color or a background graphic (like 
Windows wallpaper -- not recommended) for your Web pages. Here we see that a white background has 
been specified. 



Cache and Network Settings

The cache and network setting affect Netscape's speed and other aspects of 
performance. Tweak these settings with care! Click on the screen below to find out more
about cache and network settings.



This setting determines the size of your memory cache. If you have plenty of RAM and nothing else 
happening in the background, it's fine to increase this number slightly, but it will affect performance in 
other parts of your system. The default value is 2MB.



Click here to clear out your memory cache. This can give you a slight (temporary) gain in performance, 
particularly if you're planning to load large graphics.



Set the amount of disk space Netscape is allowed to use for temporary storage here. The Windows 
default is 5MB. If you have plenty of room on your hard drive, you may increase the amount allotted.



Click here to clear the hard-drive cache of anything Netscape has been storing in it. This often helps 
performance when loading new pages but slows Netscape down when re-loading pages you've already 
seen during this session.



Specify the directory that Netscape will use for caching here. There's no good reason to change the 
default directory.



Cahce verify allows you to specify how often Netscape must toss out a cached version of a Web page 
and go to retrieve the original. Choosing Always ensures that you'll always have the freshest version of 
fast-changing pages, but it's rough on performance. Choosing Never ensures good performance, since 
Netscape will never seek a fresher copy of a page it already has, but since Web pages change frequently 
you're likely to see stale goods. The optimal solution is to verify pages once each session.



The Network Buffer Size specifies the amount of memory allotted for network data transmissions. It's best
to leave this setting alone.



The Connections field allows you to determine how many simultaneous connections you can make. It's 
best not to change this setting without much greater experience with Netscape's memory-management 
techniques.



Applications And Directories
(or, What Netscape Can't Do On Its Own Part 1)

Netscape is able to do many Internet tasks on its own. However, to do others you will 
need to acquire certain applications to help it out. When you use one of these 
applications, Netscape "drops out" and lets you work, then returns when you're finished.
Click on the screen below for more information.



If you have a preferred telnet application, type the filename and directory here. Telnet is used for, among 
other things, remote login to other computers as well as real-time chat.



If you have a preferred 3270 emulation program, type its filename and directory here. TN3270 emulators 
allow you to telnet to IBM mainframes. You will most likely never need this capability.



If you have a preferred application for viewing HTML source code, type its filename and directory here. 
Since you can already view source code with the Source option in the View menu, you will probably never
need this capability.



Use this to indicate a directory that Netscape can use for temporary files. The directory shown (the 
default) should be just fine.



Use this field to tell Netscape where to look for your bookmark file. Netscape will automatically build a 
bookmark file on its own in the directory shown; this field is mainly useful if for some reason you are 
working with multiple bookmark files.



Click this button to begin telling Netscape about a new file type.



This window shows you all the file types with which Netscape is currently acquainted, and whether 
Netscape knows of a helper app with which to view files of that type.



After clicking on the Create button, fill in the first line of the Create form by indicating what type of file 
you're introducing (video, audio, text, etc.). The information will appear here.



After clicking on the Create button, tell Netscape the name of the file format you're introducing 
(QuickTime, RealAudio, etc.) in the second space on the form. The information will appear here.



Tell Netscape the three- or four-letter file extension carried by files of this type. Sample extensions 
are .html (for Web pages), .gif (for GIF image files), and .zip (for zipped files).



Tell Netscape what to do when it encounters a file of this type. If you have a helper application that allows 
Netscape to process the file, tell Netscape where on the hard drive it can be found. If you prefer that 
Netscape simply download files of this type, that it ask you each time what to do, or that it start up a 
separate application to work with the file, you'll indicate that here as well.



When Netscape encounters an image, it must evaluate how to display the colors. Indicate here whether 
you prefer that Netscape dither to a color cube or that it simply use the closest available color. Using the 
closest available color is slightly more efficient, but it could lead to curious results with certain images.



Netscape can show downloading images as they arrive, or it can wait to display images until every image 
on the page has transferred to you. Choosing to display images while they download will allow you to get 
an idea of what they are and to decide whether you want to wait for them to get to you. It also seems to 
make the pages load slightly faster, but that's mainly a psychological effect; actually it's faster to view 
them all at once after they've downloaded.



Netscape can alert you when you are entering or leaving a group of secure pages, when the page you're 
viewing has a combination of secure and not-secure areas, or when you're being asked to send 
information via a non-secure form. Checking these boxes causes Netscape to put a warning onscreen 
under each of these conditions. (Actual security is not affected by your choice.)



Images and Security

This screen allows you to set up several important aspects of Netscape's appearance: 
how it handles color, how it displays images, and how you are notified about security 
issues. Click on the screen below to learn more.



Helper Apps
(or, What Netscape Can't Do On Its Own Part A)

One of the great things about Netscape is that it knows how to present you with so 
many different types of files. And it's trainable: As new file types come along you can 
integrate them into Netscape. (The company is actually a lot of integration for you, but 
that's another story.) The Helper Apps window allows you to introduce new file types to 
Netscape and to determine how Netscape will handle them: by displaying them as 
easily as it does .GIF and HTML files, by saving them directly to disk, by launching an 
application on your hard drive, or by asking you what to do. Click onthe screen below for
more information.






